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Once again winter is upon
us and bad weather may
force school closure.

If the school
is closed,
we cannot
h o l d  a
m e e t i n g .
P l e a s e
check our

website — mvpcug.com for
notification of meeting
cancellation, and/or listen
to the radio for school
closings.

Tuesday, January 2, 2007- 6PM at Whitesboro HS Cafeteria
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Liz Rossi shares PowerPoint Expertise

T
his will be the first appearance of Elizabeth Rossi at an
MVPCUG meeting. She brings professional know-how to the
task of showing us—step by step—how to put together an

effective PowerPoint presentation. This very practical experience will
take place on Tuesday, January 2 at 6:00 p.m. 

All those in attendance will receive a handout that will provide the
content of her presentation so that when you get home, you’ll be able
to replicate the steps on your own computer.

Bob Schaffer attended a full-day workshop on PowerPoint that she
conducted a couple of months ago and was very impressed with her
quality instruction.

Some of the topics that will be covered include:
T A demonstration of basic slide show development techniques
T A variety of PowerPoint output options
T How to insert images and other objects into a presentation
T Tips for effective presentations
T Templates and customized shows
T Environmental concerns

Elizabeth is a part-time trainer and K-12 outreach specialist at SUNYIT.
She works with area educators to bring innovative STEM (Science,
Technology, Engineering and Math) programming to area teens with the
goal of inspiring more young people to consider STEM college paths and
careers. She also offers contract training to organizations in need of
customized skill development.

As SUNYIT's Tech Prep team leader, Elizabeth oversees SummerITeens
and the Mohawk Valley Technology Education and Pre-Engineering
Showcase. She assists in the administration of other Continuing Professional
Education programs as well. �

Call Bob Schaffer if you have a used PC
you’d donate to his adult English
language learners. Phone: 853-5984.

 On our website 

— Links of Interest —

Go to: 

mvpcug.com/index1.htm

 *bcschools.net/staff/PowerPointHelp.htm

 * actden.com/pp/

 Click on the links to find out  

more about these subjects.

http://www.mvpcug.com
http://www.bcschools.net/staff/PowerPointHelp.htm
http://www.actden.com/pp/


Stay connected . . . to the MVPCUG
Mohawk Valley PC User Group, Inc.
$25 for initial sign-up  - $20 for renewal

  Name___________________________________________________
  Address_________________________________________________
  City__________________________________________________NY
  Zip___________________Phone_____________________________
  E-mail___________________________________________________

Please mail this application with a check payable to MVPCUG to
M V P C U G
PO Box 586

Marcy NY 13403-0586
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The MVPCUG EXPLORER is published monthly from September

through June by the Mohawk Valley Personal Computer User Group,

Inc.(MVPCUG), PO Box 586, Marcy NY 13403-0586.

Opinions expressed herein are the writers and are not reflective of

the MVPCUG, nor are they considered substantiated by inclusion in

this newsletter. All articles are copyrighted by their respective authors

but may be reprinted by other User Groups provided credit is given to

the author and this publication.

The. MVPCUG was founded in 1981 by individuals interested in

IBM compatible computers. This non-profit organization consists of

volunteers whose expertise range from novice to professional.

Regular meetings are held on the first Tuesday of the month at

6pm, usually at the Whitesboro High School, Route 291, Marcy NY.

A typical agenda consists of discussion of business affairs and a

demonstration of computer related products.  Meetings are open to the

public.

Initial membership fee for an individual is $25. Annual renewal
dues are $20.

OFFICERS and DIRECTORS

President

Jerry Finkelstein . . . . . . . . . . . . . . . . . . 797-5296

. . . . . . . . . . . . . . . . . . demetrius28@adelphia.net

Vice President

Lisa Britt . . . . . . . . . . . . . . . ydaith@hotmail.com

Treasurer

Bill Gorrell . . . . . . . . . . . . . . . . . . . . . . . 853-3256

. . . . . . . . . . . . . . . . . . . . . . lwgorrell@adelphia.net

Secretary

John Hunter . . . . . . . . . . . jhunter1@twcny.rr.com

Directors-at-Large

Bob Schaffer [‘07] . . . . . rdschaffer@adelphia.net

Helen Russell [‘08] . . . . . . . . . . hrcnb@capital.net

Jim Pease [’09] . . . . . . jamesrpease@yahoo.com

Our internet presence is at

h t t p : / / w w w . m v p c u g . c o m
Web Master

Lisa Britt . . . . . . . . . . . . mvpcug@usadatanet.net

NEWSLETTER STAFF
Jerry Finkelstein . . . . demetrius28@adelphia.net
Donna Gorrell . . . . . . . . . . dgorrell@adelphia.net
John Hunter . . . . . . . . . . . jhunter1@twcny.rr.com
Bob Schaffer . . . . . . . . . rdschaffer@adelphia.net

Editorial notes. . .

Welcome back, lapsed

member—Mary Tollerton

Once again Cathy Dougherty has agreed to do our
yearly audit. Below is her business card. We hope you
will consult her if you are in need of her services.

Meeting Agenda

5:30 . . . . . . . . . . . . . . Meet and Greet
6:00 . . . . . . . . . . . . Business Meeting
6:30 . . . . . . . . . . . . . . Program, Part 1
7:10 . . . . . . . . . . . . . . . . . . . . . . Break
7:20 . . . . . . . . . . . . . . Program, Part 2
8:00 . . . . . . . . . . . Drawing for Prizes
8:15 . . . . . . . . . . . . . . . . Adjournment
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The MVPCUG general meeting was held at the Whitesboro
HS cafeteria. President Jerry Finkelstein called the meeting to
order at 6:00 PM. There were 47 persons in attendance.

BUSINESS MEETING
President Jerry Finkelstein welcomed all members and

visitors in attendance; then called for the treasurer’s report.
Treasurer Bill Gorrell reported that income was

$214.77. Expenses were $653.51. Bill reported a balance in
the checking and money market accounts of $3313.74 as of
November 30, 2006. 
     Bill noted a difference of $438.74 in expenses over
income. To address this, Bill reported he transferred $500
from the money market account to the checking account so
that annual expenses such as the yearly fee for post office
box rental, and meeting space annual rent of $250 at St.
John’s Church for SIG meetings and equipment storage
could be met. Other recurring expenses paid in November
included newsletter postage, newsletter printing, Internet
service and door prize purchase.

Then Jerry asked the membership to approve the budget
for next year. Bob Schaffer moved the budget be approved.
Nick Dudish seconded the motion. The motion passed with
one member opposed.

Jerry then indicated that the December SIG would
meet on Thursday, December 7  at 6:30 p.m. at St. John’sth

Church in Whitesboro. He encouraged anyone with
computer questions to attend.

Bob Schaffer announced that he will leave his position
as program chair in June 2007. Jerry indicated that this
position must be filled so that programs for the fall may be
arranged. Bob indicated that he will work with the new
program chair to ease the transition. Bob also announced
the programs for January through June 2007. The current
upcoming programs list appeared in the Dec. newsletter.

Bob Schaffer then thanked club members for donations
of old computer equipment for use by English language
learners Bob teaches at BOCES.

Donna Gorrell conducted the annual election of
officers. After first asking for additional nominees for office
from the floor and receiving none, Donna asked for a
motion to accept the slate of officers proposed by the Board
of Directors. Lou Barile made a motion, seconded by Nick
Dudish, that the Secretary cast one vote for the entire slate
of officers. The vote passed unanimously. With that vote,
members elected the officers for next year as proposed.

Jim Pease reported that he had contracted for Verizon
DSL service for a monthly cost of $14.95. A number of
comments about various broadband providers then ensued.

Lisa Britt cautioned, in response to a software

question, that members be sure to check hardware
requirements before purchasing software programs. New
software requires more hardware capability than many
computers two or three years old possess.

PROGRAM
At 6:30 p.m. Jerry introduced Tim Clinehens who

presented a program on the new Microsoft [MS] Vista
operating system [OS]. Tim had installed a BETA version
he received from MS on a new laptop labeled Vista
Compatible. It was no surprise to MS veterans that the
software refused to work on Tim’s machine. The only
element Tim was able to preview was a powerpoint blurb
of the Vista system. Diagnostics supplied with Vista
indicated that all elements in the laptop fit the Vista
requirements, but the OS refused to work. Neither MS nor
the laptop maker had the appropriate drivers for Vista to
run. Tim cautioned people to be very careful about
installing Vista upgrades on systems running older MS
operating systems.

In light of this unhappy experience, Tim recommends
that members purchasing new computers in the next few
months plan to stay with Windows XP until MS gets the
Vista system to work.

After a 10 minute break at 7:10 p.m. Tim’s
presentation continued until 7:40 p.m. Jerry then reported
that members had donated 61 food items and 14 toys for the
holiday gift drive headed by Dave Askew.

DOOR PRIZES
[furnished with club funds]

Staples Photo Paper (81/2X11) . . . . . . . . . . Hart Anway
Paper Shredder . . . . . . . . . . . . . . . . . . . . Tim Clinehens
DVD-R (25 pack) . . . . . . . . . . . . . . . . . . . Gary Virkler
Post-It Picture Paper (4X6) . . . . . . . . . . . . . . . Lisa Britt
Epsom Photo Paper (4X6) . . . . . . . . . . . . . Don Jennings
Sepom Matte Photo Paper . . . . . . . . . . . Mary Tollerton
Book-Dispatches from Blogistan- . . . . . . George Purpura
$20 Staples Gift Card . . . . . . . . . . . . . Salvator Carollo
$15 Best Buy Gift Card . . . . . . . . . . . . . . . . . Geri Erwin
512 MB USB Flashdrive . . . . . . . . . . . . . Howard Estey
USB cable . . . . . . . . . . . . . . . . . . . . . . . . . . Rod St.Clair

[donated by Al Fasoldt]
NIT cd/dvd Maker Suite . . . . . . . . . . . . . . . Dave Askew

[donated by Dave Askew]
CD jewel cases . . . . . . . . . . . . . . . . . . . . . . . . . Stu Culp

[donated by Rod St.Clair]
Ream of paper . . . . . . . . . . . . . . . . . . . . . . . Louis Barile
CD cases . . . . . . . . . . . . . . . . . . . . . . . . . . . Joe Madeira
Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Louis Barile

The meeting adjourned at 8:00 PM.

John Hunter, secretary �

  Minutes of December 5, 2006
— John Hunter, Secretary  



Word Processing Tips
— by Bob Schaffer
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WordPerfect — Drop Caps
by Anne Steyer Phelps
This tip courtesy of Smart Computing
December 2006 • Vol.17 Issue 12 Page70 

Drop caps are used to decorate text at the start of a
paragraph. With a drop cap, the first letter of the first
word in that paragraph is a different size than the rest
of the word.

You can add a drop cap to a blank line or at the
beginning of an existing paragraph:
T Click where you want the drop cap to appear.
T From the Format menu, choose Paragraph and

Drop Cap or just click the property bar button that
has a drop cap “A” surrounded by text. 

The Drop Caps dialog box opens with the Format
tab selected. There are three styles to choose from: 
T Drop Cap In Margin—displays the drop cap

entirely in the left margin.
T 50% In Margin—inserts it so that half displays in

the left margin and half displays in the text.
T Drop Cap In Text —inserts it entirely within the

text. 
Each style is represented by an example, so you can

see what you're choosing. 
With the style squared away, look to the Height

section. The default setting is three, which represents
the number of text lines indented at the right side of
the drop cap. Use the arrows to adjust the number of
lines or simply enter a new number. 

The final section on the Style tab is Move
Paragraph Down. Like Height, this section has a
values box and arrows to increase or decrease the
value; the default setting in this Lines box is zero. 

The Move Paragraph Down setting determines
how many lines of text are left blank at the right side
of the drop cap, as measured from the top of the drop
cap. If the value is five, for example, you’ll move four
lines down and the text will be on the same line as the
bottom of the drop cap.

When you’ve finished with the Format tab, turn to
the Font tab. All of the standard formatting options
are here, including Face, Color, Shading, and
Appearance . The default face setting is Times New
Roman, but you can change this. 

Make any other choices you like, and you’ll see the
changes reflected in the preview at the bottom of the
dialog box. 

Let's take a look at the final tab, Options. In the
Characters section, you can specify how many
characters the drop cap should include, starting with
the first letter of the current word. The default setting
is one, but you can expand it to include more. If you
want the entire first word to be the drop cap, check the
corresponding box. 

The next section, Adjustments, offers three tweaks.
Wrap Text Around Drop Cap is selected by default.
This places the text around the drop cap, rather than
through it. 

Adjust For Diacritical Marks moves the drop cap
down slightly to accommodate letters using elements
such as accent marks. 

Adjust For Descenders allows paragraph text to
wrap around drop cap characters that extend below the
text line. 

Use the Position section to dictate precisely how
much of the drop cap you want in the left margin. If
you chose 50% In Margin as your style, the Position
value and slider bar would indicate 50%. Use either the
value field or the slider to change the percentage. 

The Options tab also includes a button labeled
Border/Fill, which opens the drop cap border/fill
dialog box and lets you add a border or fill. 

Word — Choosing an Insert Method for Pictures
This tip courtesy of Bill De Lucia, Central NY PC User Group’s Saltbytes

When inserting pictures into Word documents, you
should strongly consider using the Picture option from
the Insert menu rather than doing a copy and paste. 

When cut and pasted Word treats them as TIFF files,
which are typically much larger than JPG files, even if
the original photos were JPGs.

For example, an eleven-page document with two
photos that had been cut-and-pasted into it came in at
4.5 MB in size. The same document, when the same
photos were inserted using the Insert menu shrank to
700 KB. That’s a substantial difference!

When inserting pictures by using Insert | Picture,
you can save enormous amounts of disk space as well
as communication bandwidth if the document is
emailed. In addition, the file will load faster and you
can make edits quicker. �
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DIGITAL PICTURES ARE TOO BIG
Mike called from Tacoma, WA, to say his wife’s
digital pictures are too big to e-mail. He said she takes
high-resolution photos. I answered his call on the air
but many people wanted me to repeat what I said, so
here’s the deal!

The high-resolution setting on your wife’s camera
may be uncompressed TIFFs, or JPGs with little
compression. Such files are very large.

Your wife can reduce the quality settings on her
camera. Or, she can use editing software to reduce the
size of the picture.

Windows XP will do it, too. Just right-click an
image file from Windows Explorer. Choose Send To,
E-Mail Recipient from the shortcut menu. In the next
box, the Make My Pictures Smaller option is selected
by default.

For instance, I have a TIFF file on my computer. I
used Irfanview, a free editing program, to convert it to
a JPG, a compressed format. I also set the dots per
inch to 72, which is acceptable for viewing on a
monitor or TV. I set the DPI to 300 on a second copy.
That’s a good size for printing.

These changes shrank the picture from 15
megabytes to 173 kilobytes. That’s a reduction of
nearly 99 percent. Practically any editing program can
accomplish changes like this. Here’s a link to
Irfanview: http://www.irfanview.com

LOADING AN IPOD
Q. I want to send some music to my niece. The songs
are on my computer. Can I burn them to a disc as
MP3s and send them to her? Can she load them onto
her iPod?
A. Everything you want to do is possible. Before we
start, I have to tell you that you may be violating
copyright law. You may want to consult with a team
of lawyers.

You can use programs in Windows XP or Mac’s
OS X to burn the disc. I’m assuming the songs are
already in MP3 format. If they are in WMA format,
you can use that, too.

When you make the disc, burn the files as data. If
you burn them as music, they will be much, much
larger. They will take up a lot of space on the disc,
and on your niece’s iPod. 

When your niece receives the disc, she can copy
the files directly to iTunes. If you send WMAs, iTunes
will convert them automatically to a format that the
iPod can play. If you send MP3s, iTunes will send
them in that format to the iPod. The iPod can read
MP3s. 

Need more information? I wrote a newspaper
column about loading music onto iPods.

CONNECTING WITH AN ANALOG CAMCORDER
Q. My wife gives horse training and riding lessons and
runs a Web site. Well, I run the Web site. We want to
put video clips on the site. I have a Sony Hi8 video
camera that has an S-Video out. But my computer
does not have S-Video in. I need to find some way to
get this working without breaking the bank. Can you
help me?
A. The Web is a great place to promote your business.
I happen to know from experience. But it can be
difficult getting the tools you need to really get things
off the ground.

There are two major options that will get video
from your camera to your computer. And neither is
terribly expensive. First, you can use a USB video
adapter. A basic adapter is simply a cable that
connects USB and S-Video ports.

The average cost for a basic adapter is $50. More
expensive adapters or converters add inputs that you
probably don’t need.

The second option is a PC video capture card. It
essentially supplies your computer with an S-Video
port. Some are now being sold as PVR (personal
video recorder) cards. On average, PC cards are more
expensive than simple cable adapters.

You can find some video capture cards for under
$100, but most are beyond the $100 mark.

Adapters and cards typically include software to
help with video capture. But don't forget that
Windows XP includes Movie Maker. It can handle
video capture as well, and it may outdo what is
included with your adapter.

To find Movie Maker in Windows, click Start|All
Programs| Accessories| Entertainment| Windows
Movie Maker. If it’s not in your installation of
Windows XP, you can get it from the Microsoft Web
site. �

Copyright 2005 WestStar TalkRadio Network. Subscribe
to Kim Komando's free e-mail newsletters at:

www.komando.com

PHOTOS—IPODS—CAMCORDERS
— by Kim Komando

http://www.irfanview.com
http://www.komando.com


Page 6 MVPCUG Explorer | January 2007

The holidays have ended and the January blahs
have arrived. In the past, the ‘Sites’ column has
featured interesting web sites to visit. But what about 
web site dogs? Sites to avoid: the sites that are inane
or stupid or larcenous or fatuous or boring or tasteless
or any combination of the above. My desire to
maintain balance forces me to consider the vulgar, the
vapid and the just plain bad web sites and to present a
few of these sites for your edification.

Inmates for Tea?
The first site to avoid is inmatesforyou.com. This

site offers pictures and profiles of incarcerated women
looking for letters and love, not necessarily in that
order. The site promotes relationships with female
inmates from prisons all over the country, and explains
that “Alot (sic) of these women are just like you and I
(sic) . . . they’ve made mistakes or bad choices in their
life. Now they find themselves in prison lonely and
sometimes cut off from family and friends . . .”

So, if you want to communicate with women who
even family and friends avoid, these ladies are just a
click away. Enough said.

Bow Ouch!
Another site designed to separate hard-earned

money from the unsuspicious is neuticles.com. This
site offers artificial testicle implants for neutered pets.
Apparently, 225,000 gullible individuals have
purchased these devices to be implanted during the
neutering operation. The purpose of these devices is
to protect the “self esteem” of the neutered animal and
purports to assist the animal in coping with “the
trauma associated with neutering.” Got any spare
change? You know where to send it to help Bowser.

Read Carefully
Click on whitehouse.gov and you get the official

web site of the White House, home of the president. 
If, however, you click on whitehouse.com, you take a
very different journey. This site, first appeared in 1997
as a web site “where uncensored discussion of
government policies could occur . . .” How boring. So
the web master added adult porn as an interest
generator and money maker. Be careful what you
type. You never know where you’ll wind up.

Vanity Thy Name is (supply the name)
The next web site just might appeal to some of

you. If you are in the market for cosmetic surgery,
click on bidforsurgery.com. This site offers a place for
prospective patients and doctors to come together to
negotiate a price for elective procedures such as breast
enlargements, tummy tucks and so forth. 

The site promises to introduce you to highly-
qualified, well-experienced doctors who will offer a
“bid” for your procedure. This reminds me of public
works bidding where the job goes to the lowest
bidder. Who knows? This site just might save you a
trip to Mexico or Thailand.

Doctor? Can I have a Disney Band-aid?
A well-intentioned effort to educate children about

the dangers of rabies is rabiesforkids.gov, a web site
setup by the Center for Disease Control. This site
appears to be aimed at elementary age kids and
provides clear information with colorful graphics. The
site includes maps of rabies areas and the most
common animal affected by the disease in each area.
The concern I have about this site is that children will
become enamored of the graphics and miss the
importance of the information. In this case, boring
may be better.

Dance, Dance, Dance . . .
Computer graphics find their way into everything

from TV ads to motion pictures to almost anything
you can imagine. Some graphics are good, some are
not so good. If you want to visit the site that started it
all, click on burningpixel.com/Baby/Babygif.htm. 
     This is the image of the dancing baby that started it
all, the original 1996 net-animation. If you’re into
nostalgia, you may want to visit, but be prepared for
disappointment. The image does not compete with
what we see today.

Navel Advertising?
The final site supposedly appeals to the

entrepreneurs among us. Click on rentmychest.com
and you will find a sight that offers advertising space
on a graphic of someone’s chest with links to any web
site of your choice. Prices begin at $50 and go up
depending on the font, color choice and so on. And so
it goes.

Until next time . . . �

   Sites to Visit on the ‘Net
— by John Hunter    

http://www.inmatesforyou.com
http://www.neuticles.com.
http://Www.whitehouse.gov
http://www.whitehouse.com,
http://www.bidforsurgery.com.
http://www.rabiesforkids.gov,
http://www.burningpixel.com/Baby/Babygif.htm.
http://www.rentmychest.com
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. . . that your “Favorites” list is a folder containing
shortcuts to web pages? In older versions of
Windows, the folder  was C:\Windows\Favorites. In
newer versions of Windows, it’s usually in
C:\Documents and Settings\[username]\Favorites.
You can also find the Favorites simply by hunting for
any/all folders with “favorite” as part of the name.
Once you’ve found them, you can access and edit
these folders the same way you can any other folder.
(If you can’t see or access some of your files and
folders, such as system folders, open MY
COMPUTER, choose VIEW on the menu, then
FOLDER OPTIONS | VIEW. From the list shown,
find HIDDEN FILES and click on SHOW ALL
FILES). You can copy URLs into or out of a
Favorites folder at will; rearrange, rename, sort, create
subfolders, copy/paste URLs from other locations or
other Favorites folders; do whatever you want! When
you’re done, open IE normally, and click Favorites;
you’ll see your changes reflected there.

. . . that if you reinstall WindowsXP the “My
Documents” folder gets replaced? You could lose all
your data if you use that folder to store your files.
You can ignore that folder and place all your data into
a folder of your choice. Create a new folder with a
name of your choosing, i.e., “Donna’s Data” or
“Documents”, or “My Files”. All you have to do
within your applications is go to the preferences and
select the folder to save the created files into and
apply it, from then on they will automatically save in
that folder. Of course, this does not insure that files
will be safe unless you backup regularly. Use a
separate partition on the hard drive for these files,
and/or a separate hard drive, so you can do a format
and reinstall of windows without losing any of your
data. On a partitioned HD you will lose the files if you
do a low-level format which also removes the
partition, and you have to repartition it with fdisk [or
any similar tool]. Of course all these tricks become
largely unnecessary if you regularly back up at least
your key folders, wherever they are and no matter
what they’re named. Then, you’re essentially immune
to major data loss, regardless of what happens on the
hard drive! Remember the three rules for safeguarding
your files—backup—backup—backup! �

I’m sorry Tim wasn’t able to access VISTA, the
new Microsoft OS, at our last general meeting. It
would have been nice to have a presentation and
critical commentary of the program by a member of
our club. Microsoft says VISTA will be available for
the general public sometime early in the New Year. It
is certainly one of Microsoft’s biggies, there is much
riding on it even as a newer upgrade is waiting in the
wings. For now and the near future, however, it is
VISTA. Be sure that virtually every new model PC
will arrive with VISTA installed. Indeed, some people
at our last meeting are already working with VISTA
on their PCs. Considering the ubiquitousness expected
of VISTA PCs I think we owe our members another
chance to become acquainted with this latest
Microsoft product. 

The club is pretty much booked with programs for
this year, Bob announced them at our last meeting.
Let’s hope to fit in this busy schedule a presentation
and critical assessment of VISTA. Perhaps the
presenter will throw in a “What’s New” look at the
extremely well received new Microsoft Office Suite. 

In the meantime you might want to explore the
many VISTA commentaries and reviews in the PC
magazines, hard copy or on line. PC Magazine gives
an extensive overview of the new OS. The January
issue of PC World offers a “Complete Guide.” And
our own Lisa has provided us with links to useful
VISTA material by just clicking on to our club’s
website, mvpcug.com. Lisa’s links on our website
have provided many interesting asides to our monthly
presentations; you can access the past as well as the
present links. They’re just a click away. Try them.
Can’t hurt.

Do you trust the reviews in the mainstream press?
Or do you think, as it was said at our meeting, that
they are all in the pockets of Microsoft, Intel and the
other big manufacturers with plenty of money to
corrupt? What, you don’t trust Smart Computing? A
recent issue gave good reviews to Microsoft’s Office
and WordPerfect but recommended a “cheap” office
suite to the general PC user. I don’t think PC World’s
critical commentaries of VISTA would be approved
by Microsoft. Are the reports in Consumer Reports all
legitimate? I think if you read a number of reviews you
get a decent idea of how the product is being received.
We’ll get our own people to review VISTA. I don’t
think they’ll be in the pockets of Microsoft. �

  Did You Know . . .
— Donna Gorrell   

 Byting Remarks
— Jerry Finkelstein   

http://www.mvpcug.com


Elizabeth Rossi, PowerPoint Guru
Tuesday w Jan 2, 2007 w 6:00 PM w Whitesboro High School

               what’s.com/ing January 2007             
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HAPPY NEW YEAR


